Information Technology
NVEQ Level 2 – Class X
IT207-NQ2012-Database Development (Basic)
Student’s Handbook
© PSS Central Institute of Vocational Education, 2012

Copyright protects this publication. Except for purposes permitted by the Copyright Act, reproduction, adaptation, electronic storage and communication to the public are prohibited without prior written permission.
Student Details

Student Name:______________________________

Student Roll Number:________________________

Batch Start Date:____________________________
# TABLE OF CONTENTS

## Acknowledgements

Preface

## About Your Workbook

<table>
<thead>
<tr>
<th>Session</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Database Concepts</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>Data Storage</td>
<td>13</td>
</tr>
<tr>
<td>3</td>
<td>Manipulating Data</td>
<td>19</td>
</tr>
<tr>
<td>4</td>
<td>Creating a Database Object</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>Creating a Table</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>Building Forms</td>
<td>29</td>
</tr>
<tr>
<td>7</td>
<td>Create and Manage Queries</td>
<td>35</td>
</tr>
<tr>
<td>8</td>
<td>Design Reports</td>
<td>41</td>
</tr>
</tbody>
</table>
Acknowledgements

The following partners were instrumental in providing the content:

1. Central Board of Secondary Education (CBSE) in conjunction with Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE) for providing text and exercises in Computer and IT Basics. The team involved included Dr. Om Vikas (Convener), Dr. Vinay Swarup Mehrotra (Co-Convener), Ms Gurpreet Kaur, Mr. Mukesh Kumar, Ms Nancy Sehgal and Mr. Yogesh Kumar and Mr. Rituraj Tamrakar.

2. Accenture India’s Corporate Citizenship Program (Skills 4 Life). Accenture has provided the content material they have commissioned and developed as well as access to their implementing partners (Dr. Reddy’s Foundation and QUEST Alliance) for this material.

3. Microsoft Free Digital Literacy Program eLearning package has been used to supplement CBSE/ PSSCIVE’s content.

4. The Wadhwani Foundation team involved in designing and building this curriculum and content include Ms. Darshika Sanghani, Ms. Sonia Kakkar, Mr. Karthik Chandru, Ms. Toral Veecumsee, Ms. Rekha Menon, Mr. Ajay Goel and Mr. Austin Thomas.

5. In addition, various public domain sources have been leveraged to create materials and illustrations across module. The contributions of all these sources is gratefully acknowledged and recognized.
The National Curriculum Framework, 2005, recommends that children’s life at school must be linked to their life outside the school. This principle makes a departure from the legacy of bookish learning which continues to shape our system and causes a gap between the school, home, community and the workplace.

The student workbook on “Database Development (Basic)” is a part of the qualification package developed for the implementation of National Vocational Education Qualification Framework (NVEQF), an initiative of Ministry of Human Resource Development (MHRD), Government of India to set common principles and guidelines for a nationally recognized qualification system covering Schools, Vocational Education and Training Institutions, Technical Education Institutions, Colleges and Universities. It is envisaged that the NVEQF will promote transparency of qualifications, cross-sectoral learning, student-centred learning and facilitate learner’s mobility between different qualifications, thus encouraging lifelong learning.

This student workbook, which forms a part of vocational qualification package for student’s who have passed Class IX or equivalent examination, was created by a group of experts. The IT-ITeS Skill Development Council approved by the National Skill Development Corporation (NSDC) for the IT/ITeS Industry developed the National Occupation Standards (NOS). The National Occupation Standards are a set of competency standards and guidelines endorsed by the representatives of IT Industry for recognizing and assessing skills and knowledge needed to perform effectively in the workplace.

The Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE), a constituent of National Council of Educational Research and Training (NCERT) in association with Wadhwani Foundation has developed modular curricula and learning materials (Units) for the vocational qualification package in IT/ITes sector for NVEQ levels 1 to 4; level 1 is equivalent to Class IX. Based on NOS, occupation related core competencies (knowledge, skills, and abilities) were identified for development of curricula and learning modules (Units).

This student workbook attempts to discourage rote learning and to bring about necessary flexibility in offering of courses, necessary for breaking the sharp boundaries between different subject areas. The workbook attempts to enhance these endeavours by giving higher priority and space to opportunities for contemplation and wondering, discussion in small groups and activities requiring hands-on-experience. We hope these measures will take us
significantly further in the direction of a child-centred system of education outlined in the National Policy of Education (1986). The success of this effort depends on the steps that school Principals and Teachers will take to encourage children to reflect their own learning and to pursue imaginative and on-the-job activities and questions. Participation of learners in skill development exercises and inculcation of values and creativity is possible if we involve children as participants in learning, and not as receiver of information. These aims imply considerable change in school routines and mode of functioning. Flexibility in the daily time-table would be a necessity to maintain the rigour in implementing the activities and the required number of teaching days will have to be increased for teaching and training.
About Your Workbook

This workbook is to assist you with completing the Unit of Competency IT207-NQ2012: Database Development (Basic). You should work through the workbook in the classroom, at the workplace or in your own time under the guidance and supervision of your teacher or trainer.

This workbook contains sessions which will help you to acquire relevant knowledge and skills (soft and hard) on various aspects of the unit of competency. Each session is small enough to be easily tackled and digested by you before you move on to the next session. Animated pictures and photographs have been included to bring about visual appeal and to make the text lively and interactive for you. You can also try to create your own illustrations using your imagination or taking the help of your teacher. Let us now see what the sections in the sessions have for you.

Section 1: Introduction

This section introduces you to the topic of the Unit. It also tells you what you will learn through the various sessions covered in the Unit.

Section 2: Relevant Knowledge

This section provides you with the relevant information on the topic(s) covered in the session. The knowledge developed through this section will enable you to perform certain activities. You should read through the information to develop an understanding on the various aspects of the topic before you complete the exercise(s).

Section 3: Exercise

Each session has exercises, which you should complete on time. You will perform the activities in the classroom, at home or at the workplace. The activities included in this section will help you to develop necessary knowledge, skills and attitude that you need for becoming competent in performing the tasks at workplace. The activities should be done under the supervision of your teacher or trainer who will guide you in completing the tasks and also provide feedback to you for improving your performance. To achieve this, prepare a timetable in consultation with your teacher or trainer and strictly adhere to the stipulated norms or standards. Do not hesitate to ask your teacher or trainer to explain anything that you do not understand.

Section 4: Assessment

The review questions included in this section will help you to check your progress. You must be able to answer all the questions before you proceed to the next session.
A database is an organized collection of data. You can visualize it as a container of information. The data is typically organized to model relevant aspects of reality (for example, the availability of rooms in hotels), in a way that supports processes requiring this information (for example, finding a hotel with vacancies).

Suppose if you own a stationary shop, you need to keep detailed records of the materials available in your shop. You also need to store information about pricing, stock levels for reordering, old stocks, etc. While in the manual system, you would maintain several files with different bits of information; in the computerized system you would use database programs such as Microsoft Access, OpenOffice.org Base, and MySQL, to organize the data as per your business need.

The database concept has evolved since the 1960s to ease increasing difficulties in designing, building, and maintaining complex information systems (typically with many concurrent end-users, and with a large amount of diverse data).

In this lesson, you will learn database concepts and to work with a Database Management System (DBMS).

**Database Management System**

A database management system is a software package with computer programs that controls the creation, maintenance, and use of a database. It allows organizations to conveniently develop databases for various applications. A database is an integrated collection of data records, files, and other objects. A DBMS allows different user application programs to concurrently access the same database.

Well known DBMSs include Oracle, IBM DB2, Microsoft SQL Server, Microsoft Access, PostgreSQL, MySQL, FoxPro, and SQLite.

Data can be organized into two types:

- Flat File: Data is stored in a single table. Usually suitable for less amount of data.
- Relational: Data is stored in multiple tables and the tables are linked using a common field. Relational is suitable for medium to large amount of data.

**Database Servers**

Database servers are dedicated computers that hold the actual databases and run only the DBMS and related software. Typically databases available on the database servers are accessed through command line or graphic user interface tools referred to as Front-ends; database servers are referred to as Back-ends. Such type of data access is referred to as a client-server model.
RDBMS

A relational database management system (RDBMS) is a database management system that is based on the relational model as introduced by E. F. Codd, of IBM's San Jose Research Laboratory. Most popular databases currently in use are based on the relational database model.

The relational model for database management is a database model based on first-order predicate logic, first formulated and proposed in 1969 by Edgar F. Codd. In the relational model of a database, all data is represented in terms of tuples, grouped into relations. A database organized in terms of the relational model is a relational database.

The purpose of the relational model is to provide a declarative method for specifying data and queries: users directly state what information the database contains and what information they want from it, and let the database management system software take care of describing data structures for storing the data and retrieval procedures for answering queries.

Database Concepts

Database contains objects that are used for storing and managing information. To understand a database in very simple language, let's look at the example of your address book. What do you store in an address book? You may have people's name, people's address, people's phone number and maybe even people's birthdays. There is a common element here – people. In this example, each person is considered an "item". So, an item is what the database is storing information about. When you were recording information in your address book, what did you ask the people? What is your address? What is your phone number? etc. Each question that we ask about our item is a "field". Now, say you make new friends and want to add their information to your address book. You will ask questions, get the answers and create a new "record". So a record is a set of information (made up of fields) stored in your database about one of the items. A "value" is the actual text or numerical amount or date that you put in while adding information to your database. When you put all the information together in a grid (like you do in a spreadsheet), a collection of similar records creates a table.

A database can have one or many tables. An address book example is a very simple one, in real life there are many more details involved. A big company would have in its database, one table for its products, one table for its suppliers, one table for its customer details, one for orders received and maybe many others. Basically each table in a database contains information about one type of item. So a database is basically a container that holds tables and other objects and manages how they can be used.

Another very important thing to remember is that when we put in information, we may have people with the same name (there can be more than one Charu Arora) or the same address (members of a family). But when creating a database an important feature is record uniqueness in every table. It is important to be able to distinguish between different items having duplicate values.

Uniqueness helps to avoid accidental duplication of records caused by user or computer error. This can be achieved by using some number or value that uniquely identifies a
record. If such a unique value does not exist in your fields, as the database designer, you can create a special additional field in a table where unique numbers or values can be assigned for each new entry. Therefore, every table has a key field which ensures that there are 100% unique values throughout the database.

Every database table should have one or more fields designated as key. You can assign a unique value to this key for differentiating records that may have similar names or address. Look at the following example of student database:

<table>
<thead>
<tr>
<th>Name</th>
<th>Standard</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ram</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>Sanjay</td>
<td>X</td>
<td>B</td>
</tr>
</tbody>
</table>

In this table, it will be extremely difficult to differentiate between student records as they have names that are similar. To differentiate, you can add additional field - roll number - that will be unique for each record (example below).

<table>
<thead>
<tr>
<th>Rollno</th>
<th>Name</th>
<th>Standard</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Ram</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>20</td>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>21</td>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>22</td>
<td>Sanjay</td>
<td>X</td>
<td>B</td>
</tr>
</tbody>
</table>

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Analyze database requirements for a retail shop. Record the business requirements and document. (You can use this information for creating a database to suit this business requirement)</td>
</tr>
<tr>
<td>2.</td>
<td>Analyze database requirement for your school; visit different departments such as library, student admission centre, to gather requirements. Document the business requirement. (You can use this information for creating a database to suit this requirement)</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

**Short Answer Questions**

1. What does DBMS stands for?
2. What does RDBMS stands for?
3. How is data organized in a RDBMS?
Fill in the blanks:

1. A __________ is an organized collection of data.
2. A ______________ is a software package that can be used for creating and managing databases.
3. A __________________ is a database management system that is based on the relational model.
4. Three popular DBMS software are _____________, _____________, & _________________.

SESSION 2: DATA STORAGE

RELEVANT KNOWLEDGE

Data in a relational database management system (RDBMS) is organized in the form of tables. You will now quickly recap what you learnt in the last session and assimilate more concepts.

Tables:

A table is a set of data elements (values) that is organized using a model of vertical columns (which are identified by their name) and horizontal rows. A table has a defined number of columns, but can have any number of rows. Each row is identified by the values appearing in a particular column identified as a unique key index or the key field.

Columns or Fields:

A column is a set of data values of a particular simple type, one for each row of the table. The columns provide the structure according to which the rows are composed. For example, cFirstName, or cLastName are fields in a row.

Rows or Records or Tuples:

A row also called a record or tuple represents a single, data item in a table. In simple terms, a database table can be visualized as consisting of rows and columns or fields. Each row in a table represents a set of related data, and every row in the table has the same structure.

Data types:

Datatypes are used to identify which type of data (value) we are going to store in the database. Fields themselves can be of different types depending on the data they contain. Data types in OpenOffice base is broadly classified into five categories listed below.

- Numeric Types
- Alphanumeric Types
- Binary Types
- Date time
- Other Variable types

Numeric Types:

Numeric data types are used for describing numeric values for the field used in the table of a database. Numeric data types in a database can be using for storing information such as mobile number, roll number, door number, year of school admission, true or false statements, statistical values, etc. The different types of numeric data types available are listed here.
<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOLEAN</td>
<td>yes / no</td>
<td>Values as 0 or 1. Example: True or False, Yes or No.</td>
</tr>
<tr>
<td>TINYINT</td>
<td>tiny integer</td>
<td>Store integer range between 0 to 255</td>
</tr>
<tr>
<td>SMALLINT</td>
<td>small integer</td>
<td>Store integer range between $-2^{15}$ to $+2^{15}-1$</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Integer</td>
<td>Store integer range between $-2^{31}$ to $+2^{31}-1$</td>
</tr>
<tr>
<td>BIGINT</td>
<td>big integer</td>
<td>Range between $-2^{63}$ to $+2^{63}-1$</td>
</tr>
<tr>
<td>NUMERIC</td>
<td>Number</td>
<td>Maximum precision of $e^{(\pm)2^{31}}$</td>
</tr>
<tr>
<td>DECIMAL</td>
<td>Decimal</td>
<td>Maximum precision of $e^{(\pm)2^{31}}$</td>
</tr>
<tr>
<td>REAL</td>
<td>real</td>
<td>$2^{-1074}$ to $(2-2^{-52}) \cdot 2^{1023}$</td>
</tr>
<tr>
<td>FLOAT</td>
<td>float</td>
<td>$2^{-1074}$ to $(2-2^{-52}) \cdot 2^{1023}$</td>
</tr>
<tr>
<td>DOUBLE</td>
<td>double</td>
<td>$2^{-1074}$ to $(2-2^{-52}) \cdot 2^{1023}$</td>
</tr>
</tbody>
</table>

**Alphanumeric Types:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONGVARCHAR</td>
<td>memo</td>
<td>Stores up to the max length or number indicated by user. It accepts any UTF 8 Character.</td>
</tr>
<tr>
<td>Name</td>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CHAR</td>
<td>text (fix)</td>
<td>Stores exactly the length specified by user. Pads with trailing spaces for shorter strings. Accepts any UTF 8 Character.</td>
</tr>
<tr>
<td>VARCHAR</td>
<td>text</td>
<td>Stores up to the specified length. No padding (Same as long var char)</td>
</tr>
<tr>
<td>VARCHAR_IGNORE CASE</td>
<td>text</td>
<td>Stores up the specified length. Comparisons are not case sensitive but stores capitals as you type them.</td>
</tr>
</tbody>
</table>

**Binary Types:**

Binary data types are used for storing data in binary formats. Binary data types in a database can be used for storing photos, music files, etc. In general, files of any format can be stored using the binary data type. The different types of binary data types available are listed here.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONGVARBINARY</td>
<td>image</td>
<td>Stores any array of bytes (images, sounds, etc.). No validation required.</td>
</tr>
<tr>
<td>BINARY</td>
<td>binary (fix)</td>
<td>Stores any array of bytes. No validation required.</td>
</tr>
<tr>
<td>VARBINARY</td>
<td>binary</td>
<td>Stores any array of bytes. No validation required.</td>
</tr>
</tbody>
</table>

**Date time:**

Date time data types are used for describing date and time values for the field used in the table of a database. Date time data types in a database can be used for storing information such as date of birth, date of admission, date of product sale, etc. The different types of date time data types available are listed here.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Stores month, day and year information</td>
<td>1/1/99 to 1/1/9999</td>
</tr>
<tr>
<td>Time</td>
<td>Stores hour, minute and second info</td>
<td>Seconds since 1/1/1970</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Stores date and time information</td>
<td></td>
</tr>
</tbody>
</table>

**Other datatypes:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other/Object</td>
<td>Stores serialized Java objects — user application must supply serialization routines</td>
</tr>
</tbody>
</table>

You had used the example of an address book in the previous lesson. An address book uses only one table. But look at a different situation. If you are a dealer selling a single type of item and want to record details of your sales in the past month and also want the details of the client who purchased the item (name, address, phone, date purchased, number of items bought etc), what would you do? You create a table Sales with all the details:

<table>
<thead>
<tr>
<th>OrderID</th>
<th>Customer Name</th>
<th>Customer Address</th>
<th>Phone</th>
<th>SaleDate</th>
<th>#ItemsBought</th>
</tr>
</thead>
<tbody>
<tr>
<td>000789</td>
<td>Sheela Arora</td>
<td>xxxxxxNoida</td>
<td>2444490</td>
<td>01/11/12</td>
<td>3</td>
</tr>
<tr>
<td>000790</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhaziabad</td>
<td>2443358</td>
<td>01/11/12</td>
<td>4</td>
</tr>
<tr>
<td>000791</td>
<td>Saurabh Tayal</td>
<td>xxxxNew Delhi</td>
<td>2678945</td>
<td>02/11/12</td>
<td>12</td>
</tr>
<tr>
<td>000792</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhaziabad</td>
<td>2443258</td>
<td>02/11/12</td>
<td>23</td>
</tr>
<tr>
<td>000793</td>
<td>Prashant Singh</td>
<td>xxxxRohtak</td>
<td>6784534</td>
<td>02/11/12</td>
<td>4</td>
</tr>
<tr>
<td>000794</td>
<td>Shila Arora</td>
<td>xxxxxxNoida</td>
<td>2444490</td>
<td>03/11/12</td>
<td>18</td>
</tr>
<tr>
<td>000795</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhaziabad</td>
<td>2443258</td>
<td>03/11/12</td>
<td>45</td>
</tr>
</tbody>
</table>

Do you see a problem here? Every time you sell an item to Sheela or Vaibhav or any other customer (client) you need to store the details again. So, what is the solution? Create one table for client details and another for sale details. Since each record has to be unique, you can insert a ClientID field to uniquely identify each client in the client table. In the Sales table, you would give a point of reference which “points” to a particular record in the Client table.
In the example here, the field ClientID occurs once in the Client table, but since one client can place many orders, it occurs a number of times in the Sales table. Since we cannot have an order without a customer, we call Client the parent and Sales the child table. Related tables like these share a common field. You store data about people once, but refer to those people many times in the database.

This unique field is called the primary key (PK). A primary key is a unique value that identifies a row in a table. In our example, ClientID is the primary key in the Client table. Primary Keys are also indexed in the database, making it faster for the database to search for a record.

The referred field ClientID which occurs in the Sales table is called the foreign key (FK). Hence, the foreign key identifies a column or set of columns in one (referencing) table that refers to a column or set of columns in another (referenced) table. The “one” side of a relation is always the parent, and provides the PK attributes to be copied. The “many” side of a relation is always the child, into which the FK attributes are copied. Memorize it: one, parent, PK; many, child, FK.

Another point to remember is that the end users will/may never have direct access to the database. They can only see what you permit them to and can select only from the options you give them.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
</table>
| 1.    | Create a database for a stationery shop.  
   Hint: Create fields for items, price, color, vendor, etc. |

ASSESSMENT

Short Answer Questions

1. List the data types used in a DBMS / RDBMS?
2. State the relationship and difference between a primary and foreign key?
3. List datatypes available in Numeric Datatype.
4. List datatypes available in Alphanumeric Datatype.
5. List datatypes available in Numeric Datatype.
7. 

Fill in the blanks:

1. A _________ is a set of data elements that is organized using a model of vertical columns and horizontal rows.
2. A _________ is a set of data values of a particular simple type, one for each row of the table.
3. A _________ represents a single, data item in a table.
4. _________ are used to identify which type of data we are going to store in the database.
5. A _________ is a unique value that identifies a row in a table.
In a database you can define the structure of the data and manipulate the data using some commands. There are two types of languages for this task. These are:

- Data Definition Language (DDL)
- Data Manipulation Language (DML)

**Data Definition Language (DDL)**

A data definition language or data description language (DDL) is a standard for commands that define the different structures in a database. DDL statements create, modify, and remove database objects such as tables, indexes, and users. Common DDL statements are CREATE, ALTER, and DROP.

**Data Manipulation Language (DML)**

A data manipulation language (DML) is a language that enables users to access and manipulate data in a database. The goal is to provide efficient human interaction with the system. Data manipulation involves:

- Retrieval of information from the database - SELECT statement
- Insertion of new information into the database - INSERT statement
- Deletion of information in the database - DELETE statement
- Modification of information in the database - UPDATE statement

A query language is a part of DML involving information retrieval only. The terms DML and query language are often used synonymously.

A popular data manipulation language is Structured Query Language (SQL). This is used to retrieve and manipulate data in a relational database. Other forms of DML are those used by IMS/DLI, CODASYL databases, such as IDMS and others. Data manipulation language comprises the SQL data change statements, which modify stored data but not the schema or database objects.

There are two types of DML:

- **procedural**: the user specifies what data is needed and how to get it
- **nonprocedural**: the user only specifies what data is needed. This is easier for the user but may not generate code as efficient as that produced by procedural languages.
ASSESSMENT

Fill in the blanks:

1. Types of languages used for creating and manipulating the data in the Database are ________________ & ________________.
2. A ________________ is a standard for commands that define the different structures in a database.
3. A ________________ is a language that enables users to access and manipulate data in a database.
4. A ________________ is a part of DML involving information retrieval only.
5. A popular data manipulation language is ________________.
6. Common DDL statements are __________, __________ and __________.
SESSION 4: CREATING A DATABASE OBJECT

RELEVANT KNOWLEDGE

There are a variety of DBMS/RDBMS available; in this exercise, you will learn about OpenOffice Base an Open Source RDBMS.

Launching OpenOffice

- To launch OpenOffice, click Start > Programs > OpenOffice.org 3.4.1 > OpenOffice.org. Alternatively, you can also double-click on the OpenOffice.org 3.4.1 shortcut on the desktop if available. You should see a Window similar to the one displayed below.

Select the option database to launch the base application.

You can also directly launch the OpenOffice Base Application by doing the following:

- Click Start > Programs > OpenOffice.org 3.4.1 > OpenOffice.org Base. You should be guided through the Database Wizard for creating a database. You will see a dialog box similar to the one displayed below.
You can create a new database by selecting the option **Create a new database**.

You can also open an existing database file that you have already created by selecting the option **Open an existing database file**.

Click **Next**. A dialog box similar to the one displayed below appears.

Click **Finish**. The **Save As** dialog box appears as shown below.
Specify a name for the database in the **File name** field and click **Save**. A window similar to the one displayed below.

Now that you have created a database, you can work with the database as outlined in the next few sessions.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a database</td>
</tr>
</tbody>
</table>
Short Answer Questions

1. What is the file extension for databases created using OpenOffice.Org Base?
2. List any three file formats that can be managed using OpenOffice.Org Base?
SESSION 5: CREATING A TABLE

RELEVANT KNOWLEDGE

Tables are the basic building blocks of a database. You store the data in the database in the form of tables. In the previous exercise you have learnt how to create database objects in OpenOffice.

In this exercise you will learn how to create a table in a database.

After creating the database, you see a window as shown below.

Click on Create Table in Design View… option available under Tasks and a Table Design window appears as shown below.

Specify the field name and data type of the field to be created by selecting the appropriate type available under Field type dropdown list.

Now create a table with the following fields displayed below:

Specify the field name and the data type for each field name. For example, the table contains Name field and the data type of the Name is TEXT [VARCHAR]. You can specify the length of the field value.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>VARCHAR</td>
<td>50</td>
</tr>
<tr>
<td>Rollno</td>
<td>TINYINT</td>
<td>3</td>
</tr>
<tr>
<td>DOB</td>
<td>Date</td>
<td>DD/MM/YY</td>
</tr>
<tr>
<td>Class</td>
<td>Char</td>
<td>1</td>
</tr>
<tr>
<td>Phone</td>
<td>INTEGER</td>
<td>10</td>
</tr>
<tr>
<td>Email</td>
<td>VARCHAR</td>
<td>75</td>
</tr>
<tr>
<td>Color</td>
<td>VARCHAR</td>
<td>15</td>
</tr>
<tr>
<td>Location</td>
<td>VARCHAR</td>
<td>30</td>
</tr>
</tbody>
</table>

After specifying the field name and data type for the field variables, save the table by clicking on **File > Save** shown below.

Specify the table name. The default name is Table1. Click **OK**.

A dialog box appears, similar to the one displayed below.

You are asked to set a primary key for the table you just created. You can select the appropriate option to set the primary key or leave the table without a primary key.

If you click **Yes**, the application will set the primary key for the first field created automatically. If you click **No**, you should see a window similar to the one displayed below.
Notice the table by the name SDetails created and visible under Tables section.

Create the following records:

<table>
<thead>
<tr>
<th>Name</th>
<th>Roll No</th>
<th>DOB</th>
<th>Class</th>
<th>Phone</th>
<th>Email</th>
<th>Color</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ravi Kaul</td>
<td>23</td>
<td>13/08/99</td>
<td>X</td>
<td>123456</td>
<td><a href="mailto:ravikaul@gmail.com">ravikaul@gmail.com</a></td>
<td>Blue</td>
<td>Delhi</td>
</tr>
<tr>
<td>Bijendra Dalal</td>
<td>13</td>
<td>15/01/99</td>
<td>X</td>
<td>567899</td>
<td><a href="mailto:dalal@gmail.com">dalal@gmail.com</a></td>
<td>Green</td>
<td>Mumbai</td>
</tr>
<tr>
<td>Radha Swami</td>
<td>7</td>
<td>01/02/00</td>
<td>X</td>
<td>234553</td>
<td><a href="mailto:radhasw@gmail.com">radhasw@gmail.com</a></td>
<td>Orange</td>
<td>Gujarat</td>
</tr>
<tr>
<td>Vikas Maheshwari</td>
<td>32</td>
<td>17/11/98</td>
<td>X</td>
<td>234345</td>
<td><a href="mailto:vikasm@gmail.com">vikasm@gmail.com</a></td>
<td>Blue</td>
<td>Maharashtra</td>
</tr>
<tr>
<td>Vimla Rani</td>
<td>14</td>
<td>23/09/99</td>
<td>X</td>
<td>242567</td>
<td><a href="mailto:vimla9@gmail.com">vimla9@gmail.com</a></td>
<td>Yellow</td>
<td>Orissa</td>
</tr>
<tr>
<td>Sandhya Reddy</td>
<td>26</td>
<td>19/12/98</td>
<td>X</td>
<td>213341</td>
<td><a href="mailto:sandhyaredd@gmail.com">sandhyaredd@gmail.com</a></td>
<td>Blue</td>
<td>Delhi</td>
</tr>
</tbody>
</table>

To insert values into the table, just double-click the table name, you should see a window similar to the one displayed below.

Start typing the records in the table with the data provided in the excel sheet and select **File > Save current record** to save data in the table.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a table and enter data in it</td>
</tr>
<tr>
<td>2.</td>
<td>Create a database to store your academic records using the guidelines below:</td>
</tr>
<tr>
<td></td>
<td>- Use your roll number as the file name for your database.</td>
</tr>
<tr>
<td></td>
<td>- Create fields such as subject name, required score, passing score and</td>
</tr>
</tbody>
</table>
• Set the subject name field as the primary key.

Populate your database with your most recent exam results.

**ASSESSMENT**

**Fill in the blanks:**

1. _________ are the basic building blocks of a database.

2. To design a table, you need to select _________ ________ in _________ ________ option available under Task.
A form provides the user a systematic way of storing information into the database. It is an interface in a user specified layout that lets users to view, enter, and change data directly in database objects such as tables.

In this exercise, you will learn to create a form.

To create a form, Click on **Forms** option located under Database section (Figure below).

Click **Use Wizard to Create Form…** option under **Tasks** group. The Form Wizard dialog box appears as shown below.

You can select selective fields to be sent onto the form by selecting the field name and clicking > button. You can select individual fields in a database or all fields in a database.

To use all the fields in the table in a form, click the >> button.

Notice the fields displayed under **Fields in the forms** section (Figure below).
Click **Next >**. You see the **Set up a sub form** step dialog box of the wizard as shown below.

You can select the option **Add Subform** if you need to insert the contents in the table in a separate form. Click **Next >**.

Now you need to arrange selected fields in a form. You can use different styles from the list displayed below:

Once you have selected a style, click **Next >**

A dialog box appears wherein you can select the data entry model.
Click **Next >**. You should see a dialog box wherein you can specify the styles to be used in the form.

Click **Next >**. You see a dialog box where you can specify the name of the form. Click **Finish**.

A form window appears. Notice that the records in the table are displayed automatically within the form that you just created.
You can add new records to the table using the form by clicking the symbol located at the bottom as shown below.

Once you click the symbol, you will be displayed with a window for creating records (Figure below).

You have learnt to create records using design view in the earlier sessions. You can add records using the form as displayed below. Type the following data in the textbox provided in the box as shown below:
<table>
<thead>
<tr>
<th>Name</th>
<th>Gautam</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollno</td>
<td>43</td>
</tr>
<tr>
<td>DOB</td>
<td>10/12/99</td>
</tr>
<tr>
<td>Class</td>
<td>X</td>
</tr>
<tr>
<td>Phone</td>
<td>325476</td>
</tr>
<tr>
<td>Color</td>
<td>Pink</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:gautam43@gmail.com">gautam43@gmail.com</a></td>
</tr>
<tr>
<td>Location</td>
<td>Assam</td>
</tr>
</tbody>
</table>

To view the saved records, Double-click **SDetails** (Table name) under Tables section. A window similar to the one below will be displayed; notice the record that you created using a form is also displayed along with other records (Figure below)

Now enter three more records using the form and view them using the above mentioned procedure.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a form</td>
</tr>
<tr>
<td>2.</td>
<td>Enter data in a table using a form</td>
</tr>
<tr>
<td>3.</td>
<td>Create a form for the academic database created in the earlier session.</td>
</tr>
<tr>
<td></td>
<td>Populate the academic database with mark results using the form.</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. A ______ helps the user to systematically store information in the database.

2. A ______ enables users to view, enter, and change data directly in database objects such as tables.

3. To create a form you need to select ________ option available under Database section.
SESSION 7: CREATE AND MANAGE QUERIES

RELEVANT KNOWLEDGE

Having created the tables and entering data into them, now you want to extract some information. That’s when you query the database. As the name suggests, query is to collect specific information from the pool of data. A query helps us join information from different tables and filter that information. Filtering means that the query uses criteria you provide it to hide some data and present only what you want to see.

Some RDBMS provide a graphical means to create queries, but most RDBMS do not do so. That’s where you use SQL (pronounced as “sequel”) or Structured Query Language. Query languages are computer languages used to make queries into databases and information systems. Queries are commands that are used to define the data structure and also to manipulate the data in the database.

A SELECT statement retrieves zero or more rows from one or more database tables or database views. In most applications, SELECT is the most commonly used Data Manipulation Language (DML) command.

The SELECT statement has many optional clauses:

- WHERE specifies which rows to retrieve.
- ORDER BY specifies an order in which to return the rows.

To retrieve all the columns in a table the syntax is: SELECT * FROM TABLENAME;

In order to execute queries click on the Queries option available on the left side under database section, click Create Query in SQL View as shown below.

A window appears similar to the one displayed below.
You can type the query in the above window and execute it by using the F5 function key or by clicking the icon in the window.

For example, if you want to display all the data in the table that you created in the early session, then the select statement will be: `select * from SDetails;`

After executing the select query the output will be shown similar to the one displayed below.

To get details about the list of students whose favorite color is blue, you can use:

`select * from SDetails where Color='Blue'.`  

After executing the select query the output will be shown similar to the one displayed below.

To view records in ascending order of RollNo, from the table the select statement will be:
You can add, modify or delete records using the **Insert, Update and Delete** commands.

To type and execute SQL commands, click on **Tools > SQL**. A window similar to the one below will be displayed.

You can type the SQL Commands in the **Command to execute** space and click on Execute.

**INSERT statement**

INSERT statement is used to add one or more records to a database. The general syntax of the insert statement is shown below.

\[ \text{INSERT INTO table (column1, column2, column3 ...) VALUES (value1, value2, value3 ...)} \]

To add a record in the database created earlier, type the following and click Execute.

\[ \text{insert into "SDetails" ("ID", "Name", "Rollno", "DOB", "Class", "Phone", "Email", "Color", "Location") values ('8', 'Ranjith Singh','67', '12-03-99','X', '435363', 'ranjth99@gmail.com', 'White', 'Bihar');} \]

After inserting the data into the table, use select query to view the updated table. After execution you should see a window similar to the one displayed below.

\[ \text{select * from "SDetails" order by "Rollno" ASC;} \]
UPDATE statement

Update statement is used for modifying records in a database. The general syntax of the update statement is as follows:

\[
\text{UPDATE table_name SET column_name = value [, column_name = value ...]} \quad [\text{WHERE condition}]
\]

To update a record using update statement, type the following and click Execute.

\[
\text{update "SDetails" set \text{"Location"}='Bhubaneswar' \text{where \"Rollno\"}=14;}
\]

Execute select query to view the updated table. After execution you should see a window similar to the one displayed below.

DELETE statement

Delete Statement is used to remove one or more records in a database. The general syntax of the delete statement is as follows:

\[
\text{DELETE FROM \"table_name\" [\text{WHERE} \text{condition}];}
\]

To delete one of the records in the table created earlier using delete statement, type the following and click Execute:

\[
\text{delete from "SDetails" where \text{ID}=8;}
\]
Execute select query to view the updated table. After execution you should see a window similar to the one displayed below.

![Database Table](image)

Notice the record with the Roll No 8 is deleted from the database.

**CREATE Statement**

Create statement is used for creating a database or a table in any RDBMS Software. A commonly used CREATE command is the CREATE TABLE command. The general syntax of the create statement is shown below.

**CREATE TABLE TABLENAME ([column definitions]) [table parameters]**

Column definitions: A comma-separated list consisting of any of the following

- Column definition: [column name] [data type] {NULL | NOT NULL} {column options}
- Primary key definition: PRIMARY KEY ([comma separated column list])

For example, if you would like to create a table using the Create statement, type the following and click Execute.

```sql
CREATE TABLE "Employee" ("ID" INTEGER," Name "VARCHAR (50),
    "Department" VARCHAR (50),
    "Address" VARCHAR (120),
    "Contact Number" INTEGER);
```

Now create 5 records in the table and use the SQL statements to view, modify and delete them.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open the academic database created in the previous sessions.</td>
</tr>
<tr>
<td>2.</td>
<td>Use the select query statement to query and sort on subjects marks scored</td>
</tr>
<tr>
<td></td>
<td>was greater than 50%.</td>
</tr>
<tr>
<td>3.</td>
<td>Create a database for a school library.</td>
</tr>
<tr>
<td></td>
<td>Hint: Create fields for book title, cost, provider, availability, etc.</td>
</tr>
<tr>
<td>4.</td>
<td>Create a database for maintaining a song collection.</td>
</tr>
<tr>
<td></td>
<td>Hint: Create fields for fields such as artist, movie, year released, etc.</td>
</tr>
<tr>
<td>5.</td>
<td>Create a database for collecting and maintaining census data.</td>
</tr>
<tr>
<td></td>
<td>Hint: Create fields for fields such as First Name, Last Name, DOB, Place</td>
</tr>
<tr>
<td></td>
<td>of birth, Employment Status, etc.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. A ________ is helps to collect specific information from the pool of data in the database.
2. ________ statement retrieves zero or more rows from one or more database tables or database views.
3. ________ statement is used to add one or more records to a database.
4. ________ statement is used for modifying records in a database.
5. ________ statement is used to remove one or more records in a database.
6. ________ statement is used for creating a database or a table in any RDBMS Software.
SESSION 8: DESIGN REPORTS

RELEVANT KNOWLEDGE

A report is used to generate the overall work outcome in a clear format. You can also create reports in database.

Click on Reports section under Database in the OpenOffice base application.

Once you select the option, you should see a window similar to the one displayed below.

Now we can generate the report for the table created earlier.

Click on **Use Wizard to Create Report...** option available under Tasks.

Once you select the **Use Wizard to Create Report...** option. You should see a window similar to one displayed below.

You have to select all the table fields by selecting the >> button, once you click the button >> you should see a dialog box similar to the one displayed below.
Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

You can redefine the label of the fields in the reports or else you can set the default name.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

You can define grouping for the fields of the table.
Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

You can sort the field variables in the report by selecting the appropriate field and sorting method.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

You can select the layout of the report by selecting the appropriate option available under the Layout of data down list and you can also select the orientation of the report.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.
You can define a name for the report or you can use the name of the table itself for the report also.

Click **Finish**.

Once you click **Finish** you should see a window similar to the one displayed below with the report.

Now create a report containing only Name, RollNo and Phone details. Use different layouts for the report design.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a report to display data from table</td>
</tr>
<tr>
<td>2.</td>
<td>Open the academic database created earlier.</td>
</tr>
<tr>
<td>3.</td>
<td>Design a report to display your entire academic score card.</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. A ___________ is used to generate the overall work outcome in a clear format.

2. To create reports you need to select ________________ option available under Tasks.